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COPYRIGHT NOTICE 

Copyright 2004 ArWest Communications Corp.  All rights reserved. 
No part of this publication or the computer programs described 
herein may be reproduced, translated, stored in a retrieval system, 
or transmitted in any form or by any means, electronic, mechanical 
photocopying, recording or otherwise, without prior written permis-
sion of ArWest Communications Corp.  Your rights with regard to this 
publication and the computer programs are subject to the restric-
tions and limitations imposed by the copyright laws of the United 
States of America (“U.S.A.”) and/or the jurisdiction in which you are 
located.  For information on translations and distribution outside the 
U.S.A., please contact ArWest Communications. 
 
Printed in the United States of America 
Part Number: UF-00001-100 
March 05 
 

TRADEMARK NOTICE 

ArWest is the registered trademark of ArWest Communications Corp.  
AlphaWave, AW and AWare are trademarks of ArWest Communica-
tions Corp.  All other product and brand names are trademarks or 
registered trademarks of their respective holders. 
 

SOFTWARE LICENSING AGREEMENT 

IMPORTANT: BY OPENING THE SEALED DISK PACKAGE CONTAINING THE SOFT-

WARE MEDIA OR INSTALLING THE SOFTWARE YOU ARE AGREEING TO BE BOUND 
BY THE TERMS AND CONDITIONS OF THE LICENSE AGREEMENT (‘AGREEMENT’).  
THIS AGREEMENT CONSTITUTES THE COMPLETE AGREEMENT BETWEEN YOU 
(‘LICENSEE’) AND ARWEST (‘LICENSOR’).  CAREFULLY READ THE AGREEMENT 
AND IF YOU DO NOT AGREE WITH THE TERMS RETURN THIS UBPOPENED DISK 
PACKAGE AND THE ACCOMPANYING ITEMS TO THE PLACE WHERE YOU OBTAINED 
THEM. 
 
LICENSE: LICENSOR grants you a limited, non-exclusive, non-
transferable, personal license (‘License’) to (i) install and operate the 
copy of the computer program contained in this package (‘Program’) 
in machine acceptable form only on a single computer (one central 
processing unit and associated monitor and keyboard) and (ii) make 
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one archival copy of the Program for use with the same computer.  
LICENSOR and its third-party suppliers retain all rights to Program 
not expressly granted in this Agreement. 
 
OWNERSHIP OF PROGRAMS AND COPIES.  This License is not a sale 
of the original Program or any copies.  LICENSOR and its third-party 
suppliers retain the ownership of the Program and all copyrights and 
other propriety rights therein, and all subsequent copies of the Pro-
gram made by you, regardless of the form in which the copies may 
exist...  The Program and the accompanying manuals 
(‘Documentation’) are copyrighted works of authorship and contain 
valuable trade secret and confidential information propriety to LI-
CENSOR and its third-party suppliers.  You agree to exercise reason-
able efforts to protect the proprietary interests of the LICENSOR and 
its third-party suppliers in the Program and Documentation and 
maintain them in strict confidence. 
 
USER-RESTRICTIONS.  The Program is provided for use in your in-
ternal commercial business operations and must remain at all times 
upon a single computer owned or leased by you.  You may physically 
transfer the program from one computer to another provided that 
the Program is operated only on one computer at a time.  You may 
not operate the Program in a time-sharing or service bureau opera-
tion or rent, lease, sublease, sell, assign, pledge, transfer, transmit 
electronically or otherwise dispose of the Program or Documentation, 
on a temporary or permanent basis, without prior written consent of 
LICENSOR.  You agree not to translate, modify, adapt, disassemble, 
decompile, or reverse engineer the program, or create derivative 
works of the Program or Documentation or any portion thereof. 
 
TERMINATION.  The License is effective until terminated.  The Li-
cense will terminate without notice from LICENSOR if you fail to 
comply with any of the provisions of this Agreement.  Upon termina-
tion, you must cease all use of the Program and Documentation and 
return them and any copies thereof to LICENSOR. 
 
GENERAL.  This Agreement shall be governed by and construed in 
accordance with the Laws of the State of California and the United 
States of America without regard to conflict of laws provisions 
thereof and without regard to the United Nations Convention on Con-
tracts for the International Sale of Goods. 
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DISCLAIMER OF WARRANTIES AND LIMITATIONS OF LIABILITY 

LICENSOR AND ITS THIRD-PARTY SUPPLIERS MAKE NO WARRANTIES OR REPRE-

SANTATIONS, EXPRESS OR IMPLIED, REGARDING THE PROGRAM, MEDIA, DOCU-

MENTATION, RESULTS OR ACCURACY OF DATA AND HEREBY EXPRESSLY DISCLAIM 
ANY WARRANTIES OF MERCHANTABILITY AND FITNESS FOR PARTICULAR PURPOSE 
AND NONFRINGEMENT.  LECENSOR AND ITS THIRD-PARTY SUPPLIERS DO NOT 
WARRANT THE PROGRAM WILLMEET YOUR REQUIREMENTS OR THAT IT’S OPERA-

TION WILL BE UNINTERRUPTED OR ERROR-FREE. 
 
LICENSOR, its third-party suppliers, or anyone involved in the crea-
tion or delivery of the Program or Documentation to you shall have 
no liability to you or any third-party for special, incidental, indirect or 
consequential damages (including, but not limited to, loss of profits 
or savings, downtime, damage to or replacement of equipment or 
property, or recover or replacement of programs or data) arising 
from claims based in warranty, contract, tort (including negligence), 
strict liability, or otherwise even if LICENSOR or its third-party sup-
pliers have been advised of the possibility of such claim or damages.  
The liability of the LICENSOR and its third-party suppliers for direct 
damages shall not exceed the actual amount paid for this Program 
License. 
 
Some states do not allow the exclusion of limitation of implied war-
ranties or liability for incidental or consequential damages, so the 
above limitations may not apply to you. 
 

U.S. GOVERNMENT RESTRICTED RIGHTS 

The Program and Documentation are provided with RESTRICTIVE 
RIGHTS.  Use, duplication, or disclosure by the Government is sub-
ject to restrictions as set forth in subdivision ©(1)(ii) of the Rights in 
Technical Data and Computer Software clause at DFARS 252.227-
7013 or subdivision 9©(1) and (2) of the Commercial Computer 
Software – Restricted Rights 48 CFR 52.227.19 as applicable. 
 
Should you have any questions concerning the Limited warranties 
and Limitation of Liability, please contact in writing: ArWest Commu-
nications Corp. 300 Orchard City Drive, Suite#126, Campbell, CA 
95008, USA 
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EMISSIONS 

FCC    FCC Part 90 
ETSI    300-113 
Industry Canada  RSS-119 
 

NOTICE 

Changes or modifications not expressly approved by ArWest Com-
munications Corporation could void the user’s authority to operate 
this equipment. 
 
Shielded cable must be used with this equipment in order to ensure 
that it meets the emissions limits for which it was designed.   It is 
the responsibility of the user to obtain and use good quality shielded 
cables with this device.  Shielded cables are available from most re-
tail and commercial suppliers of cables designed to work with radio 
equipment and personal computer peripherals. 
 

406.0 TO 406.1 MHZ OPERATION 

The frequency band from 406.0 to 406.1 MHz is reserved for use by 
distress beacons.  As such AW400 should not be programmed to 
transmit on any frequency within this band.  Caution should be used 
when programming frequencies into the AW400 to eliminate the pos-
sibility of AW400 users interfering with rescue operations in this 
band (US only). 
 

SAFETY WARNING 

In order to ensure the safe operation of this radio equipment, the 
following practices should be observed. 
 
DO NOT operate radio equipment near electrical blasting caps or in an 
explosive atmosphere 
 
DO NOT operate any radio transmitter unless all RF connectors are 
secure and any open connectors are properly terminated. 
 

DO NOT allow the antenna to come close to, or touch, the eyes, face, 
or any exposed body parts while the radio is transmitting. 
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1. INTRODUCTION        

1.1 WHAT IS THE ALPHAWAVE (AW) SYSTEM  

AlphaWave (AW) is a wireless system operating in the frequency 
band (50 to 800 MHz) that provides advanced features without com-
plicated system set up, it includes: 
 

• AW Radio Modem; 
• “AWare” - Windows based Unit Configuration and Mainte-

nance Software Application running on a IBM PC compatible 
computer (Distributor and User version.  

 

Figure 1-1: AW Transceiver 

The AW programmable, transparent radio modems provide real-time 
data transmission using spectrum efficient PSK/QAM modulation. It 
delivers error-free data at up to 38.4 kbps over the air for the 25 
kHz channel spacing, 19.2 kbps for 12.5 kHz, and 9.6 kbps for 6.25 
kHz.  The AW Transceiver can be provided in two versions with dif-
ferent RF Output Power. 
 
The two ports on the AW provide access to set up and test without 
unplugging the application terminal device. The setting can be done 
through the built-in Command Line interface (CLI), or through the 
configuration and maintenance application software running  on a PC 
– “AWare”.  The diagnostic feature of the AW system provides infor-
mation to monitor and maintain the user’s communications link. The 
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output transmit power, receive signal strength (RSSI), antenna/
feedline condition, and data decode performance will be transmitted 
online without application interruption. 
 
The product is designed for maximum performance and reliability 
even in the harshest environments. Plug and play at its best, robust, 
withstanding the most adverse of conditions. With up to 2 watts RF 
output the AW system offers the most popular features required for  
telemetry and SCADA systems. 

1.1.1  MODEL NUMBERS 

The AlphaWave naming protocol utilizes a two (2) letter prefix AW 
and a three (3) character suffix to identify which part of the fre-
quency range (1st character) and the RF Output Power, the particu-
lar transceiver operates on (2nd and 3rd character) 
 
AW100 138 to 170 MHz 20mW to 2W 
AW200 220 to 235 MHz 20mW to 2W 
AW400 403 to 470 MHz 20mW to 2W 
AW125 128 to 170 MHz 2W to 35W 
AW225 220 to 235 MHz 2W to 25W 
AW435 403 to 470 MHz 2W to 35W 
 
For the rest of this manual reference will be made to AW400 and 
AW435 for convenience 

1.1.2  NETWORK TOPOLOGIES 

The AW Radio Modem supports Point-to-Point link (PTP) using Time 
Division Duplex (TDD) protocol and Point-to-Multipoint (PMP) net-
work topology using Time Division Multiple Access (TDMA) protocol. 
The wireless media access contention for the PMP network can be 
resolved by an external controller through the data interface control 
lines (RTS, CTS, DTR, DSR, and DCD). In addition, the following ver-
sions of the AW software/firmware offer built-in Media Access Con-
trol (MAC) protocols to service PMP network. 
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Parameter Specification   
AW400 AW435   

Operating  
Voltage +9 to +24 VDC nominal +9 to +16 VDC range 

12VDC nominal (±10%)   
Power Consumption 
(average) 

6W, 2W, 0.05W 
Tx, Rx, Sleep 

120W, 38W, 900mW 
Tx, Tx@30% duty cycle Rx   

Operating Temp  
Range -30oC to+60oC   
Dimensions  
(D x W x H) 149mm x 74mm x 34mm 154mm x 74mm x 72mm   
Weight 12 oz / 340 g 27 oz / 765 g   
Color/Housing Two-tone Silver/Graphite, Aluminum   
Antenna Connector TNC, 50Ω, female   
RS232 Connector D15 waterproof, female   
Power Connector Through DB15 Alden Connector (300500)   

Table 1-1:     AlphaWave Physical Specifications 

Parameter Specification 
AW400 AW435 

Operating Frequency 
Range 138-170, 220-235, 403–470 MHz 
Modulation Tech-
niques GMSK/DBPSK, DQPSK, D8PSK, and D16QAM 

Radio Protocol Time Division Duplex (TDD) 
Time Division Multiple Access (TDMA) 

Max. Distance Range 50 miles (80 km) 65 miles (105 km) 
Occupied Bandwidth 
(Channel Spacing, CS) 25 kHz, 12.5 kHz or 6.25 kHz 

Data Rate (BPS) 25 kHz 
CS 

12.5 kHz 
CS 

6.25 kHz 
CS 

GMSK/DBPSK 
DQPSK 
D8PSK 

D16QAM 

9600 
19200 
28800 
38400 

4800 
9600 
14400 
19200 

2400 
4800 
7200 
9600 

System Gain 
(Ant gain not included) 146dBm 147dBm 147dBm 158dBm 158dBm 159dBm 

End to End delay 50 ms 

Table 1-2:      AlphaWave General Radio Specifications 



1.1.3  OPERATING MODES 

The AlphaWave operating modes can be set through the CLI or 
through the external management application software. The follow-
ing operating modes are available for AlphaWave radio modem: 

• Time Division Duplex with dynamic bandwidth allocation provides 
up to 9.6/19.2/38.4 kbps user data throughput. “Half Duplex” 
Base or Remote and “Repeater” are the alternative protocols for 
the time division duplex operation. 

• Simplex operating modes are developed primarily for GPS RTK 
applications. 

• Sleep mode has automatic transmitter activation by an internal 
real-time clock, or by an external controller through the data in-
terface control lines (RTS and DTR), or by the triggering of the 
external Sense Inputs. 

• Programmable automatic channel scanning of the Preferred 
Channels is an alternative mode to the operation on the fixed 
Frequency Channel. In this mode the Base Unit is looking for free 
of use frequency channel while the Remote Unit is looking for the 
Base Unit to interact with. 

• “Test” mode supports the radio installation using Built-in test 
tools. 

1.1.4  MANAGEMENT TOOLS 

Built-in management tools along with “AWare” provide the following 
benefits: 

• Easy user’s interface for system configuration and monitoring us-
ing well developed CLI or intuitive GUI. 

• An ability to test the link using built-in test utilities without ex-
pensive external test equipment such as spectrum analyzer and 
BER test analyzer. 

• An ability to monitor status, alarms and radio performance 
through the intuitive GUI. 

• Software upgrades and improvements can be downloaded from  
“AWare”, to the units connected with a PC locally or remotely, 
through the wireless link. 
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1.2 ITEMS SUPPLIED WITH AW 

Provided with each system is a transceiver (AW00 or AW435), pro-
gramming cable and a CD.  The CD includes Windows PC Interface 
Software – AWare and some training notes. 

This provides DB15 connectivity for the AW400/AW435 with a DB9 
for connection to a PC/CE Device for configuration.  For the AW400, 
two tinned cables are available for connection to an external power 
supply.  For the AW435 the same cable can be used but power is not 
available through the DB15, power to it must be supplied through 
the Power Cable with the Alden Connector. 

 

 

 

Figure 1-2:     AW400 DB15 Connector 
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Conn  
Pin # 

Signal Name Signal Description Signal 
Type 

1 DCD Data Carrier Detect O 
2 DSR Data Set Ready O 
3 RTS Request To Send I 
4 DATAIN Data from PC Serial Port to Modem I 
5 MP_DATAIN Maintenance Port Serial Data In I 
6 TTLIN2 TTL In 2 I 
7 TTLIN1 TTL In 1 I 
8 PWRIN (AW400) DC Power between 9 and 24 VDC DC 
9 DTR Data Terminal Ready I 
10 CTS Clear To Send O 
11 DATAOUT Data from Modem to PC Serial Port O 
12 MP_DATAOUT Maintenance Port Serial Data Out O 
13 TTLOUT2 TTL Out 2 O 
14 TTLOUT1 TTL Out 1 O 
15 GND DC Power and Signal to Ground I 

Table 1-3:     Standard External Connector Pin Layout  
NB:  Power in on Pin 8 only functional for AW400, this pin is not connected in 
AW435  

C
h

apter 1 



1.2.1 AW TRANSCEIVER 

Included with each AW400/AW435 (CM-10001) is a 2 meter inter-
face cable for programming purposes only—THIS IS NOT A FIELD 
DATA CABLE. 

 

Figure 1-3:     AW400 Top View 
 
 
 
 
 
 
 
 
Figure 1-4:     AW400 Side View LEDs 
 
 
 
 
Figure 1-5:     AW400 Front View RS232 
 
 
 
 
 
Figure 1-6     AW435 Top View 
 
 
 
 
 
 
 
Figure 1-7:     AW 435 Side View Bracket 
 
 
 
 
 
 
 Figure 1-8:     AW435 Front View RS232 
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1.2.2 AW400/AW435 INTERFACE CABLE 

The serial Data Interface can be configured through the software to 
operate in half and full duplex operating modes. The serial line Data 
Rate should also be under the software control, which provides the 
automatic data rate detection. 
 
RTS, CTS, DSR, DTR and CD signals should be reserved on-board for 
future support of full RS-232 hardware handshake operation. This 
will provide the support of the wide range of different standard and 
none-standard, user specific, Data Link interfaces. 
 
The serial interface is protected against static discharge (15 kV) and 
shorts with power and signal circuits. 

1.2.3.  DATA CABLE 

In order to interface an AW400 or AW435 to a third party system  
ArWest have developed an ‘open-ended’ transparent cable (see Fig 
1-9).  The user can connect whatever connector is required to the 
‘open-end’ of the cable following the correct pin protocol for this ca-
ble (CM-10005). When using this cable with an AW400 power can be 
provide by a third party system, however the Power requirement for 
the AW435  requires that this capability be disabled on the AW435. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 1-9:     AW400/AW435 Data Cable 
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1.2.4  ALARM/SENSE INTERFACE 
The Alarm/Sense Interface provides two external sense CMOS/TTL 
input lines and two TTL output lines for connection to external Alarm 
and Security systems.  The TTL output lines can be configured to in-
dicate the following alarms: 

 

1.2.5  SERIAL MAINTENANCE INTERFACE 

The serial asynchronous interface allows connection to external se-
rial devices. All commonly supported baud rates, parity and bit con-
figurations are available up to 115.2 kbps. This interface is a simple 
3-wire with RS-232C signal levels. The serial interface is protected 
against static discharge (15 kV) and shorts with power and signal 
circuits. 

1.2.6  LINK ALARM/STATUS INDICATORS 

External LED’s are used for Link and Line status indication: 
 

 

TTL_OUT1: TTL_IN1 (received from remote unit) 
TTL_IN1 and TTL_IN2 (received from remote unit) 
TTL_IN1 or TTL_IN2 (received from remote unit) 

TTL_OUT2: TTL_IN2 (received from remote unit) 
BER >10 –3 or SYNC Loss 
BER >10 –4 or SYNC Loss 
SYNC Loss 

Table 1-4:     TTL Output Lines 

           Page 1-8 

AlphaWave Users Manual                                          4/26/2006 
C

h
ap

te
r 

1 

Pos’n Led 
Name Color Description 

1 Power Green Active if Power connected to modem 

2 Link Red Active whenever a signal with a level exceeding the 
level required for reception exists on the radio channel 
(min. light on 200ms). 

3 Rx/Tx Green Active if  modem receives or transmits Data over serial 
interface (min. light on 200ms) 

4 Alarm Red Alarm indicator 

Table 1-5:     External LEDs 
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1.2.7  POWER INTERFACE 

The power interface allows connection to an unregulated DC power 
source. The DC power source (third-party or user supplied) must 
provide a minimum of 11.0 Watts of DC power between 9 and 
24VDC for the AW400 and a minimum of 38.0 Watts of power be-
tween 9 and 16VDC for the AW435.  The power interface is pro-
tected against reverse polarity connection, as well as protected 
against high-voltage transients. 

1.2.8  RF INTERFACE 

The stand-lone unit’s RF interface is a 50-ohm impedance matched 
standard BNC/TNC connector as required by regulations. It can oper-
ate without damage to the unit under DC short and open conditions. 

1.2.9  ANTENNAS 

Antenna type depends on the site requirements, and may be direc-
tional or omni-directional. The AW Base antenna is typically mounted 
on a mast that elevates the antenna a minimum of 40 feet above the 
average level of the terrain to support 50 miles distance range. 
 
The total system gain allowable includes both the Radio-Modem and 
the antenna.  The table listed below is for ArWest antennas, however 
the Gain values can be used with other antennas to determine Al-
phaWave Power Setting.  Also note Table 1-7, AlphaWave Antenna 
Cuts, in order to achieve optimum performance whip antennas 
MUST be cut to suit the actual frequency to be used. 

Antenna Part#  Gain 
dBi 

AlphaWave Power Setting  

AW400 AW435 
AT-30000 to AT-30005 0 33 dBm (2W)  45 dBm (31.62W)  
AT-30006 to AT-30007 3 30 dBm (1W) 42 dBm (15.85W) 
AT-30008 to AT-30010 5 28 dBm (0.63W) 40 dBm (10W) 
AT-30011 to AT 30015 9 24 dBm (0.25W)  36 dBm (3.98W) 
AT-30016 8.8 24 dBm (0.25W)  36.2 dBm (3.98W) 
AT-30017 to AT-30018 9 24 dBm (0.25W)  36 dBm (3.98W) 
AT-30019 to AT-30021 2.5 30.5 dBm (1.155W)  42.5 dBm (15.85W) 

Table 1-6:      AlphaWave Power Settings v Antenna 

Conn 

TNC 

NMO 

NMO 

TNC 

N 

N 

TNC 
AT-30019 to AT-30021 2.4 NMO 30.6 dBm (1.155W)  42.6 dBm (15.85W) 

C
h
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Warning: 
1. The values defined in the table must not be exceeded in order 
 to ensure compliance with RF exposure regulations. 
2 The antenna of the device may not be co-located or operating 
 In conjunction with any other antenna or transmitter. 
 
 

 

 
 
 
 

1.2.10  MAXIMUM PERMISSIBLE EXPOSURE LEVELS 

The AW435 is a High Power unit and FCC regulations now stipulate 
that Maximum Permissible Exposure Levels (MPE) be clearly indi-
cated.  The calculated safe distance for the AW435 is 93.6cm, Ar-
West recommends that operators do not get closer than one (1) 
meter during operation of the Radio, except for initial setup and final 
shut down. 
  

Antenna 
Part# 

Freq 
MHz 

Cut  
Antenna 
Part# 

Freq 
MHz 

Cut  

AT-30006** 150 48” AT-30008* 405 14” 

 152 47”  410 13” 

 154 46”  415 12” 

 156 45”  420 11½” 

 158 44”  425 11” 

 160 43½”  430 10½” 

 162 43” AT-30009* 430 12½” 

 164 42”  435 12” 

 166 41½”  440 11½” 

 168 41”  445 11” 

 170 40½”  450 10½” 

AT-30007** 200 33” AT-30010* 450 12” 

 205 32”  455 11½” 

 210 31”  460 11” 

 215 30”  465 10½” 

 220 29”  470 10” 

 225 28” AT-30022** 406-425 11” 

 230 27”  425-440 10” 

 235 26” AT-30023** 425-440 10” 

    435-450 9¾” 

   AT-30024** 450-470 9” 

Table 1-7:      AlphaWave Antenna Cuts 

All cuts made 
on antennas 
marked * 
should be 
made on the 
bottom rod 
only.  Measure 
the length of 
the rod cut 
from the lower 
edge of the 
phasing coil to 
the end of the 
whip. 
 
All cuts made 
on antennas 
marked ** on 
the bottom of 
the rod only 

 
 
 
 
 
 
 
 
 
 
 

“L” 

 
 
 
 
“L” 
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Figure 1-10:     Distance v Modulation AW400 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 1-11:     Power Consumption v Modulation AW400 
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Figure 1-12:     Distance v Modulation AW435 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 1-13:     Power Consumption v Modulation AW435 
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2. CONFIGURE YOUR ALPHAWAVE        

All AW products are shipped as Remote units with SmartScan© and 
Plug-and-Play enabled. 

2.1 PLUG AND PLAY (DEFAULT SETTING) 

Simply connect the antenna and apply power to an AW unit that has 
the same Channel Mapping as the Base unit and SmartScan© tech-
nology will immediately detect the Base Station frequency and pro-
tocol and start receiving data. 

2.2 BASE SETUP 

Use AWare “Link Protocol Properties Tab” (Figure 5-4) to convert the 
default “Remote” settings to the Base settings.  On completion of 
setting Base in the Protocol Properties ensure that the correct Proto-
col Option is then selected (Simplex Transmitter/Half Duplex). 

2.3 REMOTE SETUP 

All AW Products are shipped as Remote units, to return a unit recon-
figured as a Base or Repeater to the Remote Mode, use AWare “Link 
Protocol Properties Tab” (Figure 5-4) to convert the default “Remote” 
settings to the Base settings.  On completion of setting Base in the 
Protocol Properties ensure that the correct Protocol Option is then 
selected (Simplex Receiver/Half Duplex/RTK Repeater/Repeater). 

2.4 REPEATER SETUP 

To extend the wireless link, AlphaWave radio modems use frame re-
peating technology. 
 
A remote unit can be assigned to the “Repeater” protocol. In this 
state the unit acts as a bridge between the base unit and remote 
unit(s). A repeater unit switches between intervals of receive and 
transmit operation. It first receives one frame of data from a base 
unit, then transmits the same frame of data to unit(s) in receive 
mode, and so on with each subsequent frame of data. 
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A repeater or bridge, when strategically located in such a location to 
avoid terrain screening (on top of a high building or, a hill for exam-
ple) can greatly enhance the performance of a wireless network by 
allowing communications over distances much greater than would be 
possible without it. 
 
If a Remote Unit can receive data from a Base Unit and a Repeater 
then the remote unit will select data from the strongest signal. 
 
In order for the “Repeater” to function correctly the base unit must 
be configured correctly so it is aware that there is a repeater in the 
Network.. 
 
When a base unit is part of a wireless network using a remote Re-
peater, the repeater box underneath it must be checked for a work-
ing link to be established see figure 2-1 below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 2-1: Base Station Setup with Repeater in the Network 

 

2.5 INSTALL NEW FIRMWARE 

To install new firmware in an AW unit section 6.4 covers the 
downloading of the “embedded software images” using AWare. 
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3.  AWARE - GENERAL DESCRIPTION 

AWare is a MS Windows® based software program designed for con-
figuring and maintaining ArWest UHF radio systems. AWare is a 
user-friendly software application that provides complete and power-
ful tools for radio monitoring and diagnostics. It also provides soft-
ware image and configuration downloading. The statistics from the 
monitoring can be viewed in text or graphical format. With the sup-
port of ArWest radios’ real-time software, AWare architecture makes 
it possible to maintain all wireless network radio configuration by 
connecting to only one unit.  

 
The program consists of three panes. The left pane shows the list of 
units in the wireless link/cluster. In the root node of the tree there is 
a local unit that is directly connected, through a serial cable, to the 
management computer running AWare. The right pane is the main 
window, which displays the selected unit’s main configuration pa-
rameters and operating status. The bottom pane is a terminal win-
dow. It gives the ability to work directly with a Command Line Inter-
face (CLI), without a GUI, by entering CLI commands. The bottom 
pane also contains a log window that shows the log records coming 
from selected unit. 
 
To work with the program, the operator needs only to connect PC’s 
COM port to local unit’s maintenance port. AWare automatically gen-
erates the network tree displaying the locally connected unit in the 
root of the tree. AWare uses CLI commands for interaction with the 
radio modem. 
 
The “Dealer” version of AWare provides the tools to preprogram the 
maximum output power level, channel spacing, and channel planning 
for specific countries and users. The “End-User” version allows an 
operator to select the settings preprogrammed by the dealer. The 
“Workshop” version of AWare provides the calibration tools used by 
repair centers to recalibrate the units.  
 
Located on the ArWest Website (www.arwestcom.com), in the prod-
ucts section is a Flash Version of AWare Software Tutorial. 
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3.1  PRODUCT FEATURES 

3.1.1 MANAGEMENT 

AWare is intended to manage the ArWest radio modems, it provides 
dialog boxes to change and configure all radio options. The following 
unit’s settings are configurable through AWare: 

1. Data port parameters (Line parameters); 
2. Wireless transfer parameters; 
3. Radio parameters (TX/RX etc.) 

In addition to the individual option-tuning feature, AWare provides 
compound options for downloading feature. The downloading proc-
ess uses X-Modem protocol that both the unit and the PC program 
are supporting. The manufacturing will provide configuration in ship-
ping packages so every user can configure each unit with default pa-
rameters provided by vendor.  

3.1.2. ALARMS 

There is a callback feature for reading the radio alarms. It is possible 
to activate and deactivate this feature in any device after each de-
vice sends its alarm status to the PC where AWare is running. The 
well-designed graphical user interface on AWare shows each particu-
lar alarm on the corresponding unit and with an operator’s request 
shows detailed description of that alarm. 

3.1.3  STATISTICS 

With a right-click of the mouse on a specific option on the menu bar, 
it is possible to view the statistics information on each unit.  In the 
Statistic window an operator can see link status: number of error 
packets or bits arrived during unity of time (Bit Error Rate - BER), 
number of packets sent/received etc.). Such information can be 
shown in textual or graphical form. It is also possible to change the 
unit of time (scaling). 
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3.2  PRODUCT OVERVIEW 

3.2.1  USER INTERFACE CONVENTIONS 

AWare uses the following user interface conventions: 

• Menu options and buttons that end with three dots (...) dis-
play a dialog window when selected. . 

• Menu options that are followed by a shaded arrow display a 
submenu when selected. 

• Buttons not followed by three dots or shaded arrow performs 
a function (command) when selected. 

• Underlined letters in menu options identify keyboard short-
cuts. 

• If you are using a PC keyboard, hold down the [Alt] key and 
press the key underlined in the menu option to select that op-
tion. 

• The arrow keys on the keyboard allow an operator to scroll 
up, down, right, or left within a menu. 

• Menu options are dimmed when they are not active for a par-
ticular window. 

• All windows and dialog boxes in AWare indicate object or 
property name in the title bar for which they are activated. 

3.2.2  MAINFRAME 

The AWare Mainframe has three child windows: Site View (left 
pane), Main (right pane), and Display (bottom of the Mainframe). 
The double-clicking magnifies the child windows. The magnified child 
window can be docked back to the original position by the double-
clicking on its title bar. 
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Figure 3-1: Mainframe Default View 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 3-2: Mainframe with Undocked Child Windows 

3.2.3  SITE VIEW PANE 

This window shows the list of all units in the wireless network. The 
wireless cluster is pictured as a tree with the Base/Primary unit as 
the root. 

Operators are able to refresh the content of window through the 
main menu or popup menu by clicking mouse’s right button. The re-
fresh command can be activated manually or by setting polling op-
tion in the Preference dialog box. The system reacts on this com-
mand inactively because of slow wireless connection of the service 
channel. 

           Page 3-4 

AlphaWave Users Manual                           4/26/2006 
C

h
ap

te
r 

3 



In the “Dealer” version of AWare, the Site View Pane is also used to 
display the tree of available unit profiles. The “Unit Profile” tree pro-
vides an operator with the tools to select, add, or delete a unit pro-
file, or a folder of units’ profiles. 

The default position for Site View Pane is in the left side of main win-
dow. 

3.2.4  MAIN PANE 

AWare Main pane contains the Quick View tab that displays the se-
lected unit’s main configuration parameters and operating status. 
The Main tab is used also for the Statistics tabs, which can be acti-
vated through the Performance menu items (see section 3.2.11) 

Any of Statistics tabs can be opened and hidden by the operator. 
Meanwhile the Quick View tab is always in the Main pane and can be 
hidden only if the pane itself is hidden. 

3.2.5  DISPLAY PANE 

This window shows the log records coming from selected unit. The 
log records include all “Informative Events” with the time stamps 
along with the “System Errors/Major Alarms” and “Warnings/Minor 
Alarms”. The log information can be accumulated, even if the unit is 
not selected (in the background). This window gives the operator the 
ability to sort and filter log information by user-preferred criteria (by 
date, by type and so on). In this window, it is also possible to accu-
mulate all logs coming from AWare itself. 

The Terminal tab of the Display pane is designed for advanced op-
erators to give them an ability to work with unit directly without GUI 
using the CLI commands. 

3.2.6  MENU BAR 

The menu is a major entry point for all program features. The opera-
tor through this interface can access and change the properties of 
the AlphaWave radio. The Menu Bar consists of following items: 
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Figure 3-3: Menu Bar 

3.2.7  FILE MENU 

The configuration information is stored in the Configuration Profiles. 
The Configuration Profiles can be saved or loaded under the File op-
tion of the menu bar. If necessary, this option allows the operator to 
set the same configuration of one unit on a different unit simply by 
loading it. The operator may save as many Configuration Profiles as 
he needs.   

The File Menu contains the following commands (Figure 3-4): 

 

 

 

 

 

 

 

 

Figure 3-4: File Menu 

Where: 

New Profile – to create a New Profile; 
Open – to open a Profile from the hard or floppy disk; 
Save – to save the modified Profile to the same device from 

where it was loaded; 
Save As – to save a newly created or modified Profile on the 

specified devices with the specified name and “*.awn” exten-
sion; 

Exit – to exit AWare. 
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3.2.8  EDIT MENU 

This menu item (Figure 3-5) helps to configure the radio’s external 
and internal parameters. Those parameters are, input/output line 
properties, link configuration, radio modems configuration and so on 
(see section 5). 

The AWare Preferences item in the Edit Menu helps to setup the 
user’s Preferences for AWare. 

 
 
 
 
 
 
 
 

 

Figure 3-5: Edit Menu 

Where: 

New Unit – to add a new unit into the wireless network/link; 
Delete Unit – to delete the selected unit from the wireless net-

work/link; 
Unit Properties – to open a configuration dialog box for the se-

lected unit; 
AWare Preferences – to open AWare preferences dialog box; 
Load Configuration – to load a configuration to/from the selected 

unit from/to the open Configuration Profile. 

3.2.9  VIEW MENU 

The View menu intended to show/hide all toolbars, menus and win-
dows to construct working layout. 
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Figure 3-6: View Menu 

Where: 

Menu Bar – Show/Hide menu bar; 
Tool Bar – for hide/show the tool bar; 
Status Bar – for hide/show the status bar; 
Site View Pane – for hide/show the site view pane; 
Display Pane – for hide/show the terminal and log tabs in the dis-

play pane; 
Main Pane – for hide/show the main pane 

3.2.10  TOOLS MENU 

The Tools menu consists of following items: 

 
 
 
 
 
 
 
 

Figure 3-7: Tools Menu 

Where: 

Unit Reboot – used to access “Reboot” dialog box; 
Test Kit – provides a set of installation support and diagnostic 

utilities (see section 6.1); 
Download Image – used to access the Firmware Image 

Downloading Manager; 
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Dealer Configuration – provides a set of tools to edit and load 
Dealer Configuration Parameters (available for Dealer and 
Workshop Version); 

Factory Configuration – provides a set of tools to calibrate the 
unit and download Calibration Parameters to the unit 
(available only for Workshop Version); 

The “Dealers Configuration” sub-menu of “Tools” menu is intended 
to manipulate the dealer’s configuration File. “Dealer Configuration” 
sub-menu contains the following items (Figure 3-8): 

 
Figure 3-8: Dealer Configuration Sub-menu 

• Edit Dealer Configuration – opens dealer configuration dialog 
box to edit dealer configuration parameters 

• Export Dealer Configuration – save dealer configuration into 
the file on the disk. The New Profile dialog box uses this file to 
choose the dealer configuration as basis for network profile. 

• Import Dealer Configuration – load Dealer Configuration file 
into the system for editing it. The “Import Dealer Configuration” 
menu item also substitute dealer configuration file in the profile 
that currently active in AWare. 

• Download Dealer Configuration – download Dealer Configura-
tion parameters into the unit through the serial interface. 
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The “Factory Configuration” sub-menu of “Tools” menu provides an 
access to the tools intended for the unit calibration. “Factory Con-
figuration” sub-menu contains the following items (Figure 3-9): 
 

 
Figure 3-9: Factory Configuration Sub-menu 

• Export Factory Configuration – save dealer configuration into 
the file on the disk. The New Profile dialog box uses this file to 
choose the dealer configuration as basis for network profile. 

• Import Factory Configuration – load Factory Configuration file 
into the system for editing it. The “Import Dealer Configuration” 
menu item also substitute dealer configuration file in the profile 
that currently active in AWare. 

• Download Factory Configuration – download Factory Configu-
ration parameters into the unit through the serial interface. 

• Calibration Kit – provides access to the unit calibration tools 
(see section 6.3). 

3.2.11  PERFORMANCE MENU 

The Performance Menu is intended to retrieve the statistics from the 
unit and present the retrieved information in graphical formats: 
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Figure 3-10: Performance Menu 

Where: 

Rx/Tx Statistics – opens the tables and graphs of performance 
information unique for ArWest radio modems not covered by 
G.821 standard of ITU. 

G.821 Statistics – opens the graphs of the Error Performance Pa-
rameters and Objectives defined by G.821 standard of ITU. 

RSL - opens the graphs of received signal level for ArWest radio 

3.2.12  WINDOW MENU 

The “Window” menu (Figure 3-11) contains the following commands: 
 

 
Figure 3-11: Window Menu 

Where: 

Default Desktop – to open and arrange the windows as it was de-
signed for Default Desktop; 

Cascade – to arrange windows so they are all partially visible; 
Tile – to arrange windows horizontally or vertically so they are all 

very visible. 

3.2.13  HELP 

This menu item helps with the questions that arise about the avail-
able commands, information about commands usage and general 
information about AWare. 

Help contains the following items: 

AlphaWave Users Manual                           4/26/2006 
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Figure 3-12: Help Menu 

Where: 

Help Topics – opens application help topics in the separate dialog 
with contents, index and find tabs; 

About AWare – opens about dialog box. 
 

3.2.14  TOOL BAR ICONS 

The AWare Tool Bar contains the buttons with images so the opera-
tor can quickly associate the command with the image (see Figure 3-
13). 

 
 
 

Figure 3-13: AWare Tool Bar 

Where: 
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 Create a New Profile 

 Open Profile 

 Save Profile 

 Print Configuration(s) and User Settings 

 Add a Unit into Profile 

 Activate the selected unit’s Configuration Properties 

 Delete the selected unit from the Profile 

 Update unit’s configuration from local unit into the Profile 

 Download unit’s configuration from the Profile into the unit 

 Select Help Topic or Show About dialog 
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4. CONFIGURATION FILES 

The configuration information used by AWare is stored in four types 
of files: 

• AWare Preferences 
• Factory Configuration files  
• Dealer Configuration files  
• User Setting Profile  

Factory Configuration files can be modified only by “Workshop” ver-
sion of AWare. While Dealer Configuration file can be modified and 
loaded into the unit by “Dealer” version of AWare. 

4.1 AWARE PREFERENCES 

The “AWare Preferences” file is where AWare settings are stored. It 
includes two groups of setting parameters: 

• Startup Preferences 
• Communication Preferences 

To open the “AWare Preferences” dialog box, the operator must click 
“AWare Preferences” menu item on “Edit” menu. 

4.1.1 STARTUP PREFERENCES 

AWare allows three different startup procedures, which could be se-
lected from the “General” preferences of the preferences dialog box: 

• New Profile 
• Upload the Unit Profile 
• Open last Saved Profile 

 
and two operating modes: 
 

• Dealer/Workshop 
• User 

 
Dealer and Workshop versions of AWare provide for User and 
Dealer/Workshop operating modes. Only Dealer/Workshop operating 
provides access to Dealer and Factory Configuration Tools. 
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Figure 4-1: AWare General Preferences 
 

The Dealer and Workshop versions of AWare provide the identical set 
of tools as the User version. However, note that the wireless net-
work profile generation and modification is available only in User 
AWare is used or if User operating mode of Dealer and Workshop 
versions of AWare is selected. 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 

Figure 4-2: Communication Preferences 
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4.1.2 COMMUNICATION PREFERENCES 

The Communication preferences tab allows a variety of options for 
PC’s COM port selection (COM1 to COM8) and interface cables used 
between the unit and PC. For Dedicated Maintenance Port, the COM 
ports for both Maintenance and Data must be defined. For Non-
dedicated Maintenance Port, the shared COM port must be selected. 

By default, the Dedicated Maintenance Port is unchecked and Set-
tings for Maintenance serial port are grayed out. 

If the Dedicated Maintenance Port is checked then the MP/DP Selec-
tion Line option must be grayed out and controls for Maintenance 
serial port settings become active. 

To switch radio modem from/to Data/Command mode the Data Ter-
minal Ready (DTR) control line or three-character command se-
quence can be used. The Data/Command Switching option is pro-
vided through the “DTR / Software” list box. 

4.2 CONFIGURATION FILES 

The configuration files’ structure has a binary format to protect con-
figuration file from any type of external intervention from the user. 
The file has a tree type structure to keep information of the whole 
cluster in the root of the tree and each unit’s configuration in the 
nodes. Further changes of any parameter will be saved in the con-
figuration file in its corresponding place. 

“Dealer” and “Workshop” versions of AWare are used to create, 
modify, save on disk, and load into the units the “Dealer Configura-
tion” and “Factory Configuration” files. The “Dealer Configuration” 
and “Factory Configuration” tools are developed for this purpose (see 
sections 6-2, and 6-3).  

4.3 USER SETTINGS PROFILE 

User Setting Profile defines the settings of the wireless cluster/link 
and the units in that cluster/link. At the same time, an operator is 
able to open only one profile in AWare and work with units in that 
cluster. The User Setting profile contains two groups of information: 
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• Cluster/Link Properties – common for all units in the cluster 
• Unit Specific Properties – setting unique for each unit in the 

wireless cluster 

The group of Cluster/Link Properties includes: 

• Frequency 
• Link Data Rate 
• Topology 
• Scrambling Seed 

The group of unit specific properties includes: 

• Data Port Rate 
• Output Power Level 
• Protocol 
• Sleep mode 
• Alarm Settings 

4.3.1 CREATE A USER SETTING PROFILE 

The menu item File > New Profile creates a new User Setting Pro-
file (see Figure 4-3). By default, it creates one Base Station unit in 
the profile with factory default User Settings for that unit and opens 
unit properties dialog box to modify user settings for newly created 
unit. 

The tree on the left shows all available configurations provided by 
dealer or automatically generated from existing units. By clicking on 
each configuration, the corresponding fields on the right will show all 
settings filled up by dealer for selected item. 

The beige title on the dialog box shows the Product Name for current 
configuration.  

• Maximum Power – determines maximum output power 
 settable by the operator through the Unit Settings tools. 
• Call Sign – indicates the unique ID assigned by FCC (filled by 

 dealer). 
• Channel Spacing – defines channel spacing 25 kHz, 12.5 

 kHz, or 6.25 kHz. 
• Channel Mapping – defines the list of central frequencies 

 mapped to channel numbers. 
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Figure 4-3: New Profile Dialog Box 

The New Profile dialog box indicates the list of available units’ con-
figurations. The indicated unit configurations include Factory and 
Dealer configurations (refer to section 6.2 for Dealer Configuration). 
The full list of AW products currently supported by AWare includes: 

 

First two characters of name indicate the model family (AW). The fol-
lowing three digits after the dash is an operating frequency band: 

 

AW400 AlphaWave UHF transceiver 
AW200 AlphaWave Chinese version VHF transceiver 
AW100 AlphaWave VHF transceiver 
AW400Rx Receive-Only UHF radio 
AW200Rx Receive-Only Chinese version VHF radio 
AW100Rx Receive-Only VHF radio 
AW435 High Power UHF transceiver 
AW225 High Power Chinese version VHF transceiver 
AW135 High Power VHF transceiver 
Table 4-1:     Products supported by AWare 

400 403 to 470 MHz UHF band radio 
200 220 to 235 MHz Chinese version VHF band radio 
100 150 to 170 MHz VHF band radio 
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4.3.2 OPEN A USER SETTING PROFILE 

The full path of the User Setting Profile last used is stored in the sys-
tem registry. The program automatically opens that profile after 
starting up when corresponding option is selected in the AWare pref-
erences dialog box. 

Choosing the “Open” menu item in “File” menu opens the File Open 
dialog box. This is where the chosen profile is loaded. Then the pro-
gram automatically loads the newly chosen profile. 

4.3.3  SAVE A USER SETTING PROFILE 

To store the current user settings, the “Save” and “Save As” are be-
ing used. “Save As” menu item opens “Save File” dialog box, which 
allows an operator to store the current user settings into the differ-
ent file. 

4.3.4 ADD A UNIT INTO PROFILE 

By selecting this menu item, the program adds Remote/Secondary 
units into the Profile. A unique name and serial number of all zeros 
specified for newly added unit. From this point the operator is able 
to set the unit specific parameters or change the cluster parameters 
for all units. The newly added into profile unit has the factory default 
user settings. 

4.3.5 DELETE A UNIT FROM PROFILE 

The Delete Unit Menu item deletes the unit from the User Setting 
Profile. The delete operation can not be performed on the root item 
in the Site View configuration tree, as long as the configuration of 
the rest of all units is based on the root item’s unit. 

4.3.6  SELECT A LOCAL UNIT 

The “Local Unit” menu item specifies the unit that locally connected 
to the PC through the Serial Interface. This option used by AWare to 
substitute the Serial Number automatically (if last one is all zeros) 
with the serial number of locally connected unit during download 
process. The green icon will indicate local unit in the Profile Tree. 
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There should always be one unit in the profile and this one unit will 
be local. 

4.4 PRINTING CONFIGURATION AND USER SETTINGS FILES 

The Configuration(s)/User Settings print Forms are developed to fit 
in the portrait oriented A4 paper size. The Factory and Dealer Con-
figurations each fits in one page (see Appendixes C-1 and C-2.) For 
the User Settings each page may contain two Unit Properties tables 
(see Appendix C-3). 

Print menu item in the File menu opens a “Select Printed Forms” dia-
log:  

 

 

 

 

 

 

 

 

Figure 4-4: Select Printed Forms 

 

By default, all three printed forms are selected and User Settings 
form includes all units in the wireless cluster (for example 1-32). The 
Operator can request the User Settings print out for different units in 
the cluster by entering the Unit ID or Unit ID range, as written on 
the dialog sample. 
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5. PLANNING OF WIRELESS CLUSTER  

To open “Unit Properties” dialog box for the unit selected in the Site 
View pane, the operator can select the “Unit Properties” item from 
“Edit” menu (”Edit > Unit Properties… “.) Double-clicking on the unit 
icon in the Site View pane also opens the “Unit Properties” dialog. 

The left pane of the “Unit Properties” dialog is a unit’s User Setting 
Tree intended to facilitate and visualize the setup process. Each node 
in the tree pane corresponds to a specific tab on the dialog’s right 
side. The tab can be selected by clicking on the node in the tree. 

AlphaWave radio modems have four main groups of settings: Identi-
fication, Link, Modem and Serial Port Properties. Some of the units’ 
parameters are common for all units in the wireless link/cluster. A 
warning message appears if the operator attempts to set a parame-
ter mismatched with the rest of the units in the wireless link/cluster. 
The warning message should have an option control to automatically 
set the common parameter for all units in the wireless link/cluster or 
cancel the new setting. 

To configure the units, AWare uses CLI commands described in Ap-
pendix B 

5.1 IDENTIFICATION PROPERTIES 

On the Identification Properties tab (see Figure 5-1), there is unit’s 
identification information such as: 

• Product Name –With this option, the operator can select one 
of the ArWest radio models (see Section 4.3.1). 

• Call Sign – Indicates the unique ID assigned by the FCC (filled 
by dealer). 

• Current Software – Shows/Actives embedded software version 
that is running on the unit. 

• Unit Name – Indicates the logical name of the unit given by 
the operator. 

• Owner – Indicates the network ownership (filled by the opera-
tor). 
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The last three identification parameters (Unit Name, Owner and Call 
Sign) are user assigned settings. The Embedded Software version 
should be retrieved from the unit through its maintenance serial 
port. For AlphaWave operating in Half or Full Duplex modes it can be 
read also over the air. 

 

 

 

 

 

 

 

 

Figure 5-1: Identification Properties 

5.1.1 FACTORY PROPERTIES 

The Factory Properties is a sub-tab of the Identification Properties 
tab (see Figure 5-2). It contains the information that the vendor sets 
during manufacturing process.  
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Figure 5-2: Factory Properties 

The unit’s factory identification includes: 

• Serial Number – Indicates the serial number (six/6 bytes) of 
the unit given by the manufacture; 

• Factory Software Version – The version of software image 
loaded in factory. The factory software becomes active if op-
erator updated image is corrupted or failed. The factory soft-
ware cannot be upgraded on the field. 

• User Software Version - The version of software image 
loaded or upgraded by operator. 

5.2 LINK PROPERTIES 

The Link settings are split between three tabs: Link General Proper-
ties, Link Protocol Properties, and Link Frequency Properties. 

Changing Link Properties of unit’s configuration may cause link inter-
ruption. That is why after choosing Base/Primary unit’s configuration 
the operator has limited choices for secondary unit. 

           Page 5-3 

AlphaWave Users Manual                                    4/26/2006 
C

h
apter 5 




